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Getting started

The microscope and its peripherals (Fig. 1a) should always be turned on, but if they are not, turn them on in
the following way:

1. Turn the lasers on by turning the keys on the laser modules to the ON position. Two green LEDs lit up mean
that the laser modules are turned on, and two red LEDs mean the lasers are ready for emission (Fig. 1b).

2. Turn the sCMOS cameras on at the power board located on the left side of the computer monitor.

3. If imaging live cells, turn the Okolab stage-top incubator on. On the Okolab touch pad, set the temperature
and CO2 level accordingly. If viewing fluorescence through the oculars, turn the epi-fluorescence lamp on.

4. Turn the microscope on. The power switch is on the right side of the microscope body.

5. Turn the computer on. To log on to Windows, use “.\Nikon”, and leave the password blank. Log on to
PPMS when prompted.

6. Start NIS Elements and the Diskovery Control (Fig. 1c) by double-clicking on their icons on the desktop. A
logon window will appear. For the username, choose either “Single Camera” or “Dual Camera”. Leave the
password blank and click on “Login”. Click “Connect” on the Diskovery Control.

If a copy of NIS Elements is already open, close it and begin a fresh session. This loads the Master Layout,
with the correct optical configurations, and does not carry over any changes made by the previous user.

(a) Microscope body and peripherals. (b) Laser stack.

(c) NIS Elements (dark gray) and the Diskovery Control (light gray).

Figure 1: The Diskovery spinning disk confocal system and its user interfaces.
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Visualising a specimen through the oculars

1. To protect the objective from damage, press the “ESCAPE” button on the right side of the microscope body
(Fig. 2a, bottom). This brings the objective down, away from the specimen plane. Place the specimen on
the stage insert and press “REFOCUS” (Fig. 2a, second from bottom) to bring the objective back up to the
vicinity of its working distance.

When changing objectives, be mindful of what height the objective is at, and whether it will crash into
something when the turret revolves. It is best practice to always press ESCAPE and REFOCUS, and in this
way ensure that the objective is safe from damage.

2. On NIS Elements, choose the desired channel in the optical configurations group labelled “Oculars – view
by eye” (Fig. 2b).

3. If viewing fluorescence, open the shutter for the epi-fluorescence lamp by pressing “SHUTTER” on the lamp
controller (Fig. 2c).

Please turn off the lamp if you are the last user for the day, or if no one has booked the microscope af-
ter your session.

4. Move the specimen around using the joystick (Fig. 2d). The stage movement goes through Coarse, Fine and
Extra Fine (Fig. 2d, red LED) when the knob on the joystick stem is rotated clockwise, and goes through
the reverse order when the knob is rotated counter-clockwise.

5. Adjust the focus by using the focus controls on either side of the the microscope body or on the right side of
the joystick controller. The focus control cycles through Coarse, Fine and Extra Fine (Fig. 2d, green LED)
every time the Z speed selector is pressed.

(a) ESCAPE and REFOCUS buttons. (b) Optical configurations panel.

(c) Epi-fluorescence lamp controller. (d) Joystick and focus control.

Figure 2: Items relevant to viewing the specimen through the oculars.
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Obtaining a confocal image: Single-channel acquisition

1. After the relevant specimen region and focus are found using the oculars, switch to laser-scanning mode by
pressing “L100” on the front of the microscope body (Fig. 3a). This configures the light path so that the
laser excitation enters the microscope through the left port. Similarly, the fluorescence emission is directed
to the left port of the microscope to be detected by the cameras.

2. For single-channel acquisition, place the slider in the middle position of its travel (Fig. 3b, orange head).
This position is blank, and so all of the emitted fluorescence goes through to the horizontal camera.

3. Select the relevant channel in the “Confocal – Single Camera” group of optical configurations (“OC Panel”,
Fig. 2b), then open the laser shutter by clicking on “SPECTRAL ILE” in the “Filters, Shutters and Switchers”
window above the OC Panel.

4. On the Diskovery control, choose a pinhole size of 50 µm. This produces thinner optical sections both in
tissue and in monolayers of cells. Click on “Stopped” to make the disk spin.

5. To open the Live View window, click the “Play” button ( ) at the top of the NIS Elements menu.

6. The Zyla sCMOS camera has 65,536 gray levels when acquiring images at 16-bit (216). The Live View
window will be black in the beginning since the signal will only have ∼1,000 gray levels. Click the Auto-scale
icon ( ) on the LUTs window (Fig. 3c). This will show an image of the specimen in Live View (Fig. 3d).

7. On the Live View window, click on “Fit to Screen” ( ) to visualise the whole field of view. Move the
specimen to the desired region using the joystick or by clicking on “Mouse XY” ( ) and left-clicking and
dragging the image in Live View. Obtain the desired focus by using the focus controls or the mouse wheel.

(a) L100 port for laser-scanning. (b) Slider controlling emission path.

(c) LUTs window. (d) Live View window after auto-scaling.

Figure 3: Obtaining an image in Live View.
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A note on the uniformity of the illumination

Even though the microscope provides uniform illumination at the specimen, the sCMOS camera is not always
able to detect uniform fluorescence emission right up to the edge of its large sensor. A full-field image from
the camera is 2048 × 2048 pixels. In order to acquire images that will prove useful for quantification, it is
recommended that a region of interest (ROI) be defined from the original full field of view. Use the following
steps to define an ROI:

1. At the top of the Live View window click on the drop-down menu on the right side of the ROI icon (Fig. 4a).
Select “Define ROI. . .”. This opens a new ROI dialogue.

2. On the ROI dialogue (Fig. 4b), set the height and width to 1500 pixels. This overlays a red rectangle over
the image in Live View.

3. Click on “Center ROI” and select “OK”. This sets the ROI and ensures that all acquired images will be
uniform, without shading at the edges.

(a) Enabling an ROI in Live View. (b) Defining the dimensions of the ROI.

Figure 4: Defining a region of interest.
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Acquiring a snapshot

1. To acquire a snapshot, select each channel in turn under the “Confocal – Single Camera” group of optical
configurations on the OC Panel window (Fig. 2b). For example, if the specimen had DAPI, Alexa Fluor® 488
and Alexa Fluor® 594, begin by clicking on DAPI.

2. Set the exposure by selecting the desired exposure time on the “Zyla Settings” window (Fig. 5a). Choose
between 8-bit, 12-bit and 16-bit options for dynamic range.

3. Repeat the above process for all channels to be acquired.

4. On the ND Acquisition window, select the “λ” tab ( ) and choose the channels required. Make sure that
each channel is ticked, and that “Close active Shutter during Filter Change” is selected (Fig. 5b). This
ensures that the camera does not capture bright flashes of light when changing filters.

5. Define the path to the folder where the image will be saved. Use E:\QBI and give the file a name.

6. Click “Run now”. This captures a snapshot of the specimen. Click on Auto-scale ( ) on the LUTs window
(Fig. 5c) to produce an image with good contrast (Fig. 5d).

(a) Zyla Settings window. (b) λ tab for choosing channels to be acquired.

(c) LUTs window with channels auto-scaled. (d) Snapshot with channels auto-scaled.

Figure 5: Acquiring a snapshot.
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Acquiring a z-stack

1. On the ND Acquisition window, click on the “Z” tab ( ). Choose between the following options in setting
the the z planes to be acquired:

(a) Top/Bottom

Press the Top/Bottom icon ( , Fig. 6a). This renders the cube blue. On “Z Device”, select “NIDAQ
Piezo Z”, which is faster than the Nikon Ti internal Z drive.

While in Live View, move the focus to the top position and press “Top”, then move to the bottom
position and press “Bottom”.

Define the step size in µm, or use the Nikon software’s calculated optimal step size by clicking on the
numerical value to the right of “Step”. Click “Run now”. This acquires the stack.

(b) Home Position (Symmetric and Asymmetric)

Press either the Symmetric ( ) or Asymmetric ( ) home position icons (Fig. 6a). Both will render
the cube yellow. On “Z Device”, select “NIDAQ Piezo Z”.

Move the focus to the desired reference position and press “Home”. Symmetric mode places this
position at the centre of the range specified, while asymmetric mode requires the distances below and
above the home position to be specified.

Define the step size in µm or the number of steps to be captured. Click “Run now”. This acquires the
stack.

2. On the icons at the top of the image window (Fig. 6b), choose between “Show Main View” ( ), “Show Slices
View” ( ), “Show Volume View” ( ), “Show Tiled View” ( ), “Show Maximum Intensity Projection” ( ),
and “Show Minimum Intensity Projection” ( ). Each rendering option opens in a new window.

3. If a separate maximum intensity projection image of a z-stack is required, go to Image → ND Processing
→ Create Maximum Intensity Projection Image in Z. This creates a new file which can then be saved and
analysed.

(a) “Z” tab for acquiring z-stacks. (b) 3D volume view on NIS Elements.

Figure 6: Acquiring a z-stack.
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Performing a tile scan

The microscope can perform a tile scan using its motorised XY stage, and NIS Elements automatically stitches
the tiles together after the raw images are captured. There are two ways to perform a tile scan: “Scan Large
Image” under the “Acquire” menu and “Large Image” on the ND Acquisition window. Based on previous tests,
Scan Large Image appears to stitch tiles better, therefore choose this option.

1. Scan Large Image

NOTE:
The Scan Large Image window renders the rest of NIS Elements greyed out and inaccessible. For this reason,
open Live View first.

Go to Acquire → Scan Large Image. This opens a new window (Fig. 7a, left).

Under “Capturing”, make sure that the correct Scanning Objective is chosen.

Under “Z Series”, choose between “None”, “Z Series” and “Max IP”, which acquires a z-stack then produces
a maximum intensity projection image of the stack. On “Z-drive”, select NIDAQ Piezo Z.

Both “Z Series” and “Max IP” assume that the specimen plane in Live View is the central z-plane, so bring
the focus to the central focal plane.

If acquiring multiple channels, tick “Multi-channel capture” and select the appropriate channels. Select the
channel the software will use for stitching.

Set the array of frames by defining the number of fields, or set the area to be scanned by defining the left,
right, top and bottom limits.

Tick “Close active shutter during stage movement”.

Under “Stitching”, set the overlap to 5 %, select stitching via “Optimal path”, and tick “Image Registra-
tion”.

Choose between “Create large image”, “Store single images” or “Create both”.

Tick both “Save large image to file” and “Keep file opened”.

Define the file path and name, and click “Run now”. This captures the individual tiles, which NIS Elements
stitches thereafter (Fig. 7b).

If a tile scan with a z-stack that has the top and bottom planes defined is required, make sure that stitching
via optimal path and image registration are selected in Scan Large Image, then use the Z tab on the ND
Acquisition window to define the z-planes, and the Large Image tab to perform the tile scan.

2. Large Image

Click on the “Large Image” tab ( ) on the ND Acquisition window (Fig. 7a, right). Large Image
assumes that the specimen region in Live View is the central region.

Set the array of frames by defining the number of fields or the size of the scanned area in mm2.

Under Stitching, tick “Stitch” and choose the channel the software will use for stitching.

Set the overlap to 5 % and tick “Close active shutter during stage movement”.

Define the file path and name, and click “Run now”. This captures the individual tiles and stitches them
together.
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(a) “Scan Large Image” window (left) and “Large Image” tab (right) for performing a tile scan.

(b) A 2×2 tile scan after stitching.

Figure 7: Performing a tile scan.
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Time-lapse acquisition

1. On the ND Acquisition window, click on the “Time” tab ( ). This presents a “Time schedule” where
time phases can be added as required (Fig. 8a).

2. To configure each time phase, click on the drop-down menus for “Interval” and “Duration” to set the desired
time between time points and the desired length of the time-lapse, respectively.

3. Select the file path and name, and click “Run now” to start the acquisition.

Multi-point acquisition

1. On the ND Acquisition window, click on the “XY” tab ( ). This presents a list to which points in XY can
be added as required (Fig. 8b).

2. Tick “Move Stage to Selected Point”.

3. Tick “Include Z” if the Z position is also required (for example, if the specimen is not flat).

4. Move the stage to the desired specimen region and obtain the correct focus. Click on the “Add” button ( ).
This adds a row containing the current XYZ coordinates.

5. Move the stage to all the desired positions and click on the “Add” button each time.

6. To change the Z coordinate of a point, select the relevant point on the list. The stage will move that point’s
coordinates automatically. Adjust the focus and click the button.

7. Select the file path and name, and click “Run now”.

(a) “Time” tab on the ND Acquisition window. (b) “XY” tab for multi-point acquisition.

Figure 8: Time-lapse and multi-point acquisition.
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Simultaneous dual-channel acquisition

1. To image two channels simultaneously, choose “Dual Camera” in the logon window that appears when
starting NIS Elements. If switching from single-channel to dual-channel acquisition, close the current NIS
Elements session and start a new one.

2. Position the slider (Fig. 3b, orange head) on the Diskovery module to its innermost position. This places a
dichroic mirror in the emission path that reflects short wavelengths (blue and green fluorescence) up to the
vertical camera and transmits long wavelengths (red and far red) through to the horizontal camera.

3. Select the desired channels in the “Confocal – Dual Camera” group of optical configurations (Fig. 9a). This
activates the relevant pair of laser lines for fluorescence excitation (Fig. 9b).

4. Select the λ tab on the ND Acquisition window and choose the channels to be acquired (Fig. 9c).

5. If a z-stack, tile scan, time-lapse or multi-point acquisition is required, use the same procedure as has been
described for single-channel acquisition.

6. Click “Run now” to acquire an image (Fig. 9d).

(a) Dual-channel optical configurations. (b) Simultaneous excitation with two laser lines.

(c) λ tab for dual-channel acquisition. (d) Simultaneous dual-channel snapshot.

Figure 9: Simultaneous dual-channel acquisition.
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Total internal reflection fluorescence microscopy

Total internal reflection fluorescence (TIRF) microscopy, developed by D. Axelrod and colleagues in the 1980s
[1, 2, 3], is an extension to fluorescence of the total internal reflection microscope of E. J. Ambrose three decades
prior [4, 5]. Ambrose wanted to study the contacts formed between cells and solid surfaces and he argued that
one could make use of the slight penetration of light waves into the less dense medium when totally internally
reflected at an interface.

Ambrose used a prism to make light strike a glass/water interface at an angle greater than the critical angle,
thus achieving total internal reflection. He reported that in reality the beam penetrates the less dense medium
(water) slightly, so that portions of cells which make close contact with the glass are brightly illuminated.
Increasing the angle of the incident beam decreased the degree of penetration, thereby illuminating only those
regions “which are almost in molecular contact with the glass surface” [4].

Axelrod called Ambrose’s penetrating beam the “evanescent wave”, and due to its very thin penetration depth
and the fact that its intensity decayed exponentially with distance from the glass surface, fluorescence excitation
only occurs within a few hundred nanometres of the glass. This results in a high signal-to-noise ratio, with no
out-of-focus fluorescence collected from the cell cytoplasm or cellular debris [6].

Perform TIRF microscopy in the following way:

1. On NIS Elements, in the “Ti Pad” window, select the Apo TIRF 60x oil-immersion objective (position 6).

Remember to press ESCAPE and REFOCUS when changing objectives.

2. On the Diskovery module (Fig. 10a), under “OBJECTIVE”, click on “60X”. Click on “Spinning” to make
the disk stop spinning and on “Disk Out” to take the disk out of the optical path. Click on “TIRF Disabled”
to enable TIRF. This will open a new window.

3. On the TIRF window (Fig. 10b), click on “Insert Prisms”. Tick the desired laser line for fluorescence
excitation, then click “Oblique Illumination” and “Go”.

4. Select the desired channel under the “TIRF – Single Camera” group of optical configurations (Fig. 2b) if in
single-channel mode, or under “TIRF – Dual Camera” (Fig. 9a) if in dual-channel mode.

5. Click on “TIRF” in the “Filters, Shutters and Switchers” window to open the laser shutter. Open the Live
View window.

6. To lock the focus on the coverslip and avoid drifting during image acquisition, press “FOCUS” on the front
of the microscope body. This activates Nikon’s Perfect Focus System (PFS).

NOTE:
When Perfect Focus is engaged, the focus adjustments on the microscope body and joystick controller are
disabled. Adjust the focus using the knob on the Nikon PFS controller.

7. The TIRF window displays the current penetration depth in nm. Note that this value is only an estimate
and therefore not exact. Drag the slider to the left to decrease the depth, or to the right to increase it. Tick
“Hi-Resolution” to enable 10 nm shifts in the depth, otherwise the depth will shift by 100 nm.

8. Set the desired exposure time on the “Zyla” window. Choose the channels required on the λ tab of the ND
Acquisition window.

9. Define the file path and name and click “Run now” to acquire the TIRF image (Fig. 10c). Note the contrast
between the TIRF image and its widefield counterpart (Fig. 10d).
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(a) Diskovery Control for enabling TIRF. (b) TIRF window.

(c) TIRF image of a cell. (d) Widefield image of the same region.

Figure 10: Image acquisition in TIRF.
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Ending a session

1. Lower the objective by pressing “ESCAPE” on the microscope body. Remove the specimen.

2. If an oil-immersion objective has been used, gently wipe off the oil using lens tissue.
Never use Kimtech Wipes to clean objectives.

3. If ending a session of TIRF imaging, deselect all laser lines on the TIRF window and select “Clear Prisms”.
Click on “Return”. This brings back the Diskovery Control window.

4. On the Diskovery Control window, click on “Disconnect”.

5. Close both the Diskovery Control and NIS Elements and live a happy life.
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Troubleshooting

1. I cannot see the control windows (OC Panel, Spectral ILE Pad, Zyla Settings, etc.) in NIS Elements.
Click on “Docked Controls” on the bottom left corner of NIS Elements.

2. I cannot see the laser.
Open the shutter by clicking on SPECTRAL ILE.

3. I have SPECTRAL ILE clicked but I still cannot see the laser.
Close the shutter and open it again by clicking on SPECTRAL ILE twice.

4. I have clicked SPECTRAL ILE multiple times but I still cannot see the laser.
Turn the key on the laser module to the OFF position then bring it back to the ON position again, then
click SPECTRAL ILE.

5. The lamp on the incubation unit does not turn on.
Make sure that the power cable for this lamp is connected.

6. I have made sure that the power cable for the lamp on the incubation unit is connected but the light still does
not come on.
Turn off the microscope and turn it on again.

7. I turned off the microscope and turned it on again. Now I cannot see my image in Live View. It was there
before I turned the microscope off. My specimen is on a dish.
When the microscope is turned on, it brings the stage to the central XY position relative to the slot for a
slide. Move the stage to where the dish is located.

8. I cannot see the light from the bright-field lamp.
Open the bright-field lamp shutter by clicking on “DIA”.

9. I cannot see my image in Live View.
Click Auto-scale on the LUTs window.

10. I have clicked Auto-scale. I still cannot see my image.
If the z-position as displayed on the microscope body is ∼500 µm, bring the objective to the correct focal
plane by pressing “REFOCUS”.

11. What should the new z-position be after I press “REFOCUS”?
It should be ∼2800 µm.

12. The image I see in Live View has dots everywhere. Why is that?
The dots are the pinholes on the disk, and they are visible because the disk is stopped. Make the disk spin
by clicking on “Stopped” on the the Diskovery Control.

13. I switched from single- to dual-channel acquisition. Why can’t I see a thing on the DAPI or A488 channels?
I have clicked Auto-scale twice, mind you.
Position the slider (Fig. 3b, orange head) on the Diskovery module to its innermost position to divert DAPI
and A488 to the vertical camera.

14. I switched from dual- to single-channel acquisition. Why can’t I see DAPI or A488? I have clicked Auto-
scale, so that’s not it.
Position the slider (Fig. 3b, orange head) on the Diskovery module to its middle position. This transmits all
fluorescence to the horizontal camera.

15. I switched from single- to dual-channel acquisition (or vice-versa). Now the image I see in Live View is all
wrong. My specimen is mounted on a slide.
When NIS Elements is started, it brings the stage to the central XY position relative to the slide and a
z-position of 2800 µm (the vicinity of the focus). Move the stage to where you want it to be using the
joystick and adjust the focus accordingly.

16. I switched from single- to dual-channel acquisition (or vice-versa). Now I cannot see an image in Live View.
My specimen is on a dish.
When NIS Elements is started, it brings the stage to the central XY position relative to the slot for a slide.
Move the stage to where the dish is located.
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17. The Live View window is not displaying my image properly: the top and lower halves look disjointed.
Close NIS Elements and turn the cameras off, then on again, using the power board on the left side of the
computer monitor. Start NIS Elements again.

18. I think there is a problem with TIRF. There is a very bright region at the top of the Live View window.
Remove the 1.5x lens from the optical path by turning the black knob at the front of the microscope body.

19. The software is not stitching my tiles properly.
Make sure that the “Zoom” above the “LUTs” window is set to the correct value (1.00x or 1.50x).

20. I have the Zoom at 1, which is what I always use, but my tiles still aren’t being stitched properly.
Make sure that the 1.5x lens is out of the optical path by turning the black knob at the front of the microscope
body.

21. NIS Elements is not allowing me to acquire z-stacks. It says “N/A” for the range and everywhere else.
Under “Range”, click on “N/A” and type in a numerical value.

22. I wish to convert my .nd2 file to .tif, with separate z-stacks for each channel.
Open the file in NIS Elements then go to File → Export → ND Export to TIFF. Under Channels, select
“Mono image for each channel”, and under Index order > Dimension, select “z first, then c”, and under
Multi-page, select “z”.

23. Will I be able to open my .nd2 files in Fiji? What about in Imaris?
Yes, Imaris will open .nd2 files. On Fiji, use the Bio-Formats Importer by going to Plugins → Bio-Formats
→ Bio-Formats Importer.

24. When I try to start NIS Elements, it comes up with a prompt that says “Could not open camera driver!” If
I click OK, NIS Elements continues to load, but I cannot find the Live View button.
Exit NIS Elements, then shut down the computer. Turn off the cameras at the power board on the left side
of the monitor. Wait 15 seconds then turn them on again (a soft reset). Turn off the microscope body using
the power switch on its right side. Wait 15 seconds and turn it on again. Start the computer, then start NIS
Elements again.

25. I wish to acquire a z-stack so I set the Top and Bottom planes (or the Home position) but the z-stack is all
wrong: the images are blurry. I think the microscope took images of the wrong z-planes.
On the bottom right side of the Live View window, “PiezoZ” should be at 250.00 µm. Go to the Z tab on
the ND Acquisition window and press the Piezo icon ( ). This centers the piezo stage while keeping the
current z position. The PiezoZ value on the Live View window should then read 250.00 µm. Define the Top
and Bottom planes again, or the Home position when using Symmetric or Asymmetric mode, and this time
the stage should go to the correct z-planes.
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